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Quantarctica version 1.0 is the result of an 
initiative by the Norwegian Polar Institute (NPI) 
to develop and host a collection of geographical 
data sets and software freely available for non-
commercial use, with offline capabilities to 
explore the Antarctic region, aimed at research, 
education and operational use. The current 
version is the first release of the package, with 
data collected from data centres around the 
world. This is a tool for and by the user 
community. Data sharing is encouraged!

In the practical sense, Quantarctica (Quantum GIS + Antarctica = "Quantarctica") is a Quantum GIS project presenting 
a basemap of the world south of 50 degrees latitude, on top of which the end users can work with preloaded scientific  
data sets or load their own; to create, visualize, analyze and present Antarctic geographical data.

The Quantarctica Package                                                                                            

Quantum GIS (QGIS). This is the software part of Quantarctica. QGIS is a powerful, user friendly 
and open source geographic information system (GIS) that runs on Linux, Mac OSX, Unix, 
Windows and Android. It was first released in 2002, and is licensed under the GNU General Public 
License. It supports a range of vector, raster and database data formats, and connects to a several 
types of online map services. The core functionality can be extended with plugins and scripting.

The basemap data. Quantarctica comes with basemap data for Antarctica and the Southern Ocean, 
featuring coastlines, ice edges, elevation contours, facility locations, place names etc., provided as 
vector data in the ESRI Shapefile format. Also included are e.g. elevation models and satellite 
imagery, provided as raster data in GeoTIFF and JPEG formats.

The scientific data. The package includes scientific data, mainly glaciology themes in this first 
release, but also geophysical data.

The Quantarctica package comes in three separate components; the main project component and 
two high-resolution imagery data components, all downloadable from the Quantarctica website.

The main project component (~7GB), folder structure:
     Quantarctica
          - Basemap – Imagery, Miscellaneous, Terrain, Vector. The imagery folder contains continent-wide 100–300 m 
            resolution mosaics, as well as full coverage of LIMA_CIRREF imagery (tiled Landsat imagery, 15 m resolution,
            false-color, pan-sharpened, derived from bands 4, 3, 2, photo date 1999–2002).
          - MyDataFolder (Empty. User's personal data folder).
          - Scientific (Geophysics, Glaciology).
          - Software (QGIS installer for Windows. Plugins and QGIS user guide).      Cont.->

http://www.quantarctica.org/


The high-resolution imagery data component, part I: LIMA_MOS (~13GB), folder structure:
     LIMA_MOS (tiled Landsat imagery, 15 m resolution, derived from bands 4, 3, 2, 1, photo date 1999–2002).

The high-resolution imagery data component, part II: RADARSAT (~15GB), folder structure:
     RADARSAT (tiled RADARSAT imagery, 25 m resolution).

When downloading the imagery, it should be put in the corresponding Basemap/Imagery/Tiles/ folders already present 
in the main project component, and which already holds the ancillary files for each image.

Quantarctica Setup                                                                                                        

Download Quantarctica. The package compontents mentioned above, can be downloaded from the 
project website. Downloading the main project component would probably be enough to start with. 
You can read more about accessing large imagery data in the section Explore Quantarctica Part II.

The rest of this guide is based on Quantum GIS 1.8 for Windows.

Install QGIS. Launch the Quantum GIS standalone installer included in the main project 
component (QGIS-OSGeo4W-1.8.0-2-Setup.exe), and follow the instructions. (No demo datasets are 
necessary to use Quantarctica.) When completed, restart the computer and double-click the QGIS 
project file Quantarctica.qgs in the Quantarctica folder to launch the project for the first time.

Install Plugins. Beyond the core functionality, numerous plugins are available to extend it. 
Currently, more than 200 plugins exist for QGIS in the official plugin repository. Plugins can be 
easily installed to QGIS through the core embedded Plugin Installer, and run from the Plugins 
toolbar and menu (some install to other menus). As part of the installation of QGIS, some plugins 
might be assumed handy for everyone to install. For convenience, these are already downloaded and 
available in the Plugin folder of the main project component. There are two ways to install them. (a) 
Copy the subfolders from the Quantarctica Plugin folder, and paste them into the user specific 
folder of your system, e.g. in C:\Users\JohnDoe\.qgis\python\plugins. (For multiuser computers, 
you probably need to create the python and plugins folder too.) Then, in QGIS, click the Plugins 
menu and select Manage Plugins... and check the plugin checkboxes to enable them. (b) Click the 
Plugins menu in QGIS, and select Fetch Python Plugins, search for and install these plugins:

- Points2One Convert a series of points into tracks
- Profile Tool See the cell values along a profile of a raster layer, e.g. elevation
- Table Manager Edit the attribute table structure, e.g. rename or rearrange fields
- Value Tool See the value of the raster cell below the mouse cursor

Points2One Profile Tool              Value Tool

Other plugins to consider (not bundled in Quantarctica): *
- Closest Feature Finder Click anywhere in the map to highlight the most nearby feature.
- Dockable MirrorMap Duplicate the map canvas, and view different layers in each.
- Numerical Vertex Edit Set the precise location of any point or line vertex when editing data.
- Point Sampling Tool Transfer multiple raster values to point dataset at point position.                                 
- Quick Finder Search attributes, like place names, more efficiently.                                                   
- RasterCalc Perform algebra operations on a raster dataset.                                                            
- Sextante Exposes conveniently e.g. the rich GRASS functionality to QGIS.                             Cont.->



- Statist Calculate and view different statistics for a vector layer field.
- TimeManager Animate temporal vector dataset, like animal movements.

* Some of these are experimental. Read about accessing experimental plugins in the next section.

First Time Launch: QGIS Tuning                                                                                

The next step is some optional and one-time QGIS tuning and customizations. From the Plugins 
menu, click Fetch Python Plugins. In the Options tab in the appearing box, enable QGIS to Check 
for updates on startup, and select it to do so e.g. once a day. In the Allowed plugins menu, Show all  
plugins, even those marked as experimental.

From Settings/Options menu, consider the following adjustments:
- In the General tab, change the Icon size to 16 pixels
- In the Rendering tab, check the Rendering behavior: Use render caching ...
- In the Rendering tab, uncheck the Rendering quality: Make lines appear less jagged ...
- In the Locale tab, consider to Override system locale, and set to en_US
- Click OK to apply and finish

Consider hiding rarely used toolbars from the interface. Right-click to the right of the Help menu, 
and uncheck the following toolbars in the appearing context menu: Database, GRASS, Label, 
Raster, Vector and Web. Similarly, you might want to set Coordinate Capture (Read a map point's 
coordinates in e.g. decimal degrees.) to visible by checking it in the list.

Now, this is much about personal preference, but some might think the width of the map canvas is 
too large compared to the height. You can expand the height at expense of the width by docking the 
different top toolbars on the left side of the QGIS application interface. You might want to keep the 
most frequently used toolbars closes to the map canvas for convenience. Suggestion: Click and hold 
the left "rubber-band" edge of the File toolbar                          , and drag and drop it to the same 
height and on the left side of the Layers panel. Beneath, place the Digitizing toolbar                         , 
and then the Advanced editing toolbar                          . To the immediate right of the File toolbar, 
drop the Manage Layers toolbar                          , and beneath, the Plugins toolbar                          . 
To the right of the Manage Layers toolbar, drop the Map Navigation toolbar                          , and 
beneath this, the Attributes toolbar                          .

You might want to have neither the Value Tool nor the Coordinate Capture panels visible by default. 
Simply click the close button                      in the top right corner of the panels. However, if you 
want to keep them, you can group them to take less space (creates tabs)                                  , by 
taking hold of the rubber band right of the Coordinate Capture label, and drag and drop it on top of 
the Value Tool panel, and then minimize both in vertical extent by dragging the rubber band below 
the Control rendering order checkbox downwards.

Close and restart the QGIS to save these changes.

Some general Quantarctica recommendations
- Rename the MyDataFolder folder in Quantarctica, to your user name.
- Save your own data in your personal folder.
- Save the default Quantarctica project as a new and personal project file in the same folder where the default 
Quantarctica project is situated (if you are dependent on the Add full resolution image from local disk functionality 
described below).
- Add your own data in your personal project file.
- Save regularly when editing data, and do data backups.



Explore Quantarctica. Part I – Basic Operation                                                        

When opening the Quantarctica QGIS project, a basic map of Antarctica is the only visible data in 
the map canvas. However, a range of preloaded datasets are available for display in the tree 
structure in the Layers panel. Let's go through some basic operation of Quantarctica.

Activate detailed basemap. To turn on a more 
detailed basemap, check the box to the left of the 
Detailed basemap item in the Layers panel. A map 
with topographical themes and bathymetry will appear.

Navigate in the map. Click the Zoom In button       in the navigation toolbar, and draw a rectangle 
around e.g. the Antarctic Peninsula, and repeat to zoom closer in to a specific area. As you will see, 
the level of detail increases as you zoom in. Click the Pan Map button        in the navigation toolbar 
to pan around in the map. Try using the mouse wheel, and see how zooming is very convenient that 
way too.

Toggle place names. The main project component includes two 
place names datasets. One for overview purposes, and one with the 
complete list of place names in Antarctica. Now, zoom out to see 
the whole of the continent, do this by clicking the Zoom Full  
button      . Then, expand the Miscellaneous folder by clicking the 
tree node       to the left of it, and check the GeneralNames layer 
(don't click the Miscellaneous folder checkbox, it will toggle all 
layers in the group, not just the place names). Zoom in a step to see 
more clearly the selected Antarctic overview names. Turn off the 
place names again, and now check the SCAR Place names layer. A lot of points populate the map 
canvas. To see the actual place name labels, zoom further in. (This kind of scale dependent 
rendering is used for many layers to keep large-area views simple and small-area views information 
rich.) Collapse the Miscellaneous folder, or scroll in the layers list to locate the Detailed basemap 
entry. Toggle it to get a feeling with which landscape features the names represent.

Switch to satellite view. Uncheck Detailed basemap (for 
performance reasons), and expand the Satellite imagery folder. 
From the expanded list, click the Landsat RGB Antarctica mosaic 
checkbox, and the image appears on top of the simple basemap. To 
view the image in its native resolution, make sure that the Landsat 
layer is marked in grey or blue in the layers list (meaning, it has the 
focus), and click the concurrently enabled Zoom to Native Pixel  
Resolution button      .

Get map feature info. Turn off all layers except the Simple 
basemap, expand the Miscellaneous folder, and check the 
COMNAP-listed [main] facilities layer. Zoom to the extent of the 
dataset by clicking the Zoom to Layer button      . Now you see the 
facilities. To read the specific info on any particular facility in the 
map, zoom in on one of the facilities, make sure that the COMNAP 
layer is selected (shown in gray or blue) in the layers list, click the 
Identify Feature button       in the toolbar and then on a facility 
point in the map. A box titled Identity Results appears, and here are 
all the data about this specific facility for you to study. Close and 
click e.g. on the Pan Map button to leave identify mode.



View dataset metadata. To read the general info 
about a dataset, e.g. the UTM zones dataset, check 
it to be visible, and double-click the layer in the 
layers list. A Layer Properties box appears. At the 
top of this, several tabs are shown. Click the 
Metadata tab, and here you will see what this 
specific dataset is about.

Stop waiting for QGIS to draw the map. If you accidently activate a layer's or layer group's 
visibility, you can sometimes cancel the rendering process. Also, you can temporarily disable 
rendering while you turn on and off a series of layers you would like to see together, and then 
enable the rendering when you're ready. This might give a smoother QGIS experience when 
working with heavy datasets. These rendering tools are located in the lower right corner of QGIS. 
Try checking the Miscellaneous layer group checkbox and cancel rendering with (repetitive) clicks 
on the Stop rendering button       or by pressing the ESC key on your keyboard. Then uncheck the 
Miscellaneous layer group, uncheck Toggle map rendering                , turn on or off a few layers, 
and check the Toggle map rendering again.

Explore Quantarctica. Part II – More Essentials                                                       

View country specific place names. To just view e.g. the names approved by New Zealand, right-
click the SCAR Place names layer, and from the appearing context menu, click Query. In the 
appearing Query Builder, double-click Country in the Fields list, then the equals sign in the 
Operators box, and then click the All button in the Values box. From the appearing list, double-click 
New Zealand. As you can see in the box SQL [Structured Query Language] where clause, you now 
select to show only the place names where "Country" = 'New Zealand'. Press OK, and you'll see 
only the names approved by New Zealand.

View attribute table. A vector dataset has an 
associated data table that hosts all the non-
geometric information on the features, like the 
information you've seen with the Identify  
Feature tool in the Basic Operation tutorial. 
To view more than one feature's associated 
data at a time, you can open the attribute table 
by right-clicking the layer, e.g. the SCAR 
place names, and selecting Open Attribute  
Table. The box that appears, resembles 
spreadsheet software, and you can expand columns, sort and select records similarly as in regular 
spreadsheets. In this particular place name table, you will see only the New Zealand approved place 
names, because of the data query above. Select a few of the records (click on the record number to 
the left, hold down the Ctrl key, and click some others). Now, minimize the table, and click the 
Zoom to Selected button      . Deselect with the Deselect Features from all layers button      .

Add high-resolution satellite imagery. Quantarctica comes with high-resolution Landsat (CIRREF 
and MOS) and Radarsat imagery of Antarctica. Rather than a single mosaic covering the whole 
continent, these images are tiled into 150x150 km squares. CIRREF imagery, which represents the 
most "natural looking" imagery of the three, is distributed as a part of the main project component. 
To load a specific CIRREF tile, first make the Landsat CIRREF Tile index layer under the Satellite  
imagery holder visible. Then zoom in on a specific area. While the layer is marked with grey or 



blue in the layers list, from the Run Feature Action dropdown menu 
         , select Add full resolution image from local disk, and click the 
tile in the map you want to load. The tile should appear in the map 
and the layers list (it automatically loads the right tile from the local 
Quantarctica Tiles folder).

To load imagery not locally available, you need to download it from 
the Quantarctica website. You can download all in two Landsat  
MOS or Radarsat zip files, or tile by tile as you need them, within 
QGIS. To load a high-resolution RADARSAT imagery tile for a 
specific part of Antarctica, first toggle the RADARSAT Tile index 
layer. While the layer is marked with grey or blue in layers list, click 
the Run Feature Action button dropdown menu, and select Get full  
resolution image from Quantarctica website. Then click on the 
index tile that covers the spot you want the high-resolution imagery for. Your default web browser 
will open the download page for this specific image tile. Unzip the downloaded image into the 
corresponding folder in the Quantarctica main folder structure (Basemap/Imagery/  
Tiles/RADARSAT). At that point, you can either drag and drop the TIF file onto the map canvas, or 
use the Add full resolution image from local disk described above, and click the index tile again.

Adjust image contrast. If you zoom in on any specific part of a satellite image, you can stretch the 
contrast to see the details better, e.g. fine glacier structures in Radarsat imagery. A convenient way 
to do this is with a right-click on the image in the layers list, and then Stretch using current extent.

Export map. The most straight-forward way to take your current map view out of QGIS, is to 
export it into a graphical image file, like TIFF or JPEG. From the File menu, simply click the Save 
as Image. However, if you want more advanced exports with higher resolution and perhaps a scale 
bar, a north arrow, a legend and maybe some other customizations, the Print Composer in File 
menu is more versatile and can produce both vector and raster exports for your papers.

See layer without preset styling. Layers in Quantarctica comes with preset styling by default, 
including labeling, transparency and scale-dependent rendering settings. To view a dataset without 
the preset styling, either manually change it, or temporarily rename the dataset's QML file.

Working with GPS data. QGIS supports uploading and downloading of data to a range of handheld GPS units, directly 
and through  GPX file import and export. (Functionality located in the Vector/GPS menu). Also, there are some 
capabilities to connect a GPS through a serial port on the computer, and have live tracking  in the map as you go. 
(Toggle GPS panel through the View/Panels/GPS Information menu entry.)

Some more Quantarctica recommendations
- Consider removing layers loaded in the default project but irrelevant to you. This will make the project launch faster. 
Right-click the layer in the layer list and select Remove. (Removes from the project only, not from disk.)
- Generally, have only visible layers checked. A layer totally covering another layer (lies above it in the Layers panel, 
and without preset/custom transparency), makes the covered layer unnecessary to render, and decreases performance.
- Although QGIS can render and work with data of different projections at the same time, it is generally recommended 
that when creating data, it should be projected to the default projection.

Further reading
- Included in the Software folder in the Quantarctica main project component, there is the official Quantum GIS User 
Guide. Also, online resources exists on the Quantum GIS website at www.qgis.org.

Please read the Important Notice text file in the main Quantarctica folder for general terms and disclaimer.


